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Thank you for purchasing the Janome Robot. 
 
*Read this manual thoroughly in order to properly use this robot. 
Be sure to read “For Your Safety” before you use the robot. It will 
protect you from possible dangers during operation. 

*After having read this manual, keep it in a handy place so that you or the 
operator can refer to it whenever necessary. 

 
 

 

 

 

 

 

 

 



 FOR YOUR SAFETY 

 
  Safety Precautions 
 
The precautions stated in this manual are provided for the customer to make the best use of this 
product safely, and to provide preventive measures against injury to the customer or damage to 
property. 
 

・・・・・Be sure to follow the instructions・・・・・ 
 
Various symbols are used in this manual. Please read the following explanations to understand what 
each symbol stands for. 

● Symbols Indicating the Degree of Damage or Danger 

The following symbols indicate the degree of damage or danger which may be incurred if you 
neglect the safety notes. 

 

Warnings 

Cautions These “Cautions” indicate the possibility of accidental injury or 
damage to property. 

These “Warnings” indicate the possibility of death or serious injury.  

 

 

 

● Symbols Indicating the Type of Danger and Preventive Measures 

The following symbols indicate the type of safety measure that should be taken. 
 

     Indicates prohibition. 

Do not touch. (contact prohibition) 

Never do this. (general prohibition) 

Be sure to unplug power cord from wall outlet. 

Do not disassemble, modify or repair. 

Be sure to follow instructions. 

Be sure to check grounding. 

      Indicates necessity. 

     Indicates the type of safety measure that should be taken. 

Take care. (general caution) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

PC Operation                                                JS/JSR4400N SCARA Robot 
JSG GANTRY Robot 

JR2000N Desktop Robot  

i



Be sure to check grounding. 
Improper grounding can cause electric shock or fire. 
 

Be sure to use within the voltage range indicated on the unit. 
Failure to do so may cause electric shock or fire. 
 

Plug the power cord into the wall outlet firmly. 
Failure to do so can cause the input to heat up and may result in fire.  
Make sure that the power plug is clean. 

 

Be sure to unplug the power cord from the wall outlet when you 
examine or grease the machine. 
Failure to do so may cause electric shock or injury. 
  
If anything unusual (e.g. a burning smell) occurs, stop operation and 
unplug the cable immediately. Contact your dealer or the office listed on 
the last page of this manual.  
Continuous use without repair can cause electric shock, fire, or breakdown 
of the unit. 
 
Install the robot in a place which can endure its weight and conditions 
while running. 
Placing the unit in an insufficient or unstable surface may cause the unit to 
fall, overturn, or breakdown. This could result in operator injury. 
Be sure to leave a space of at least 30cm between the back of the robot 
(equipped with a cooling fan) and the wall. Insufficient space can lead to 
overheating or fire. 
 
Be sure to take protective measures such as installing an area sensor 
or enclosure to avoid injury. 
Entering the robot’s work range during operation could lead to injury. 
 
Do not attempt to disassemble or modify the unit. 
Disassembly or modification may cause electric shocks or malfunction. 

Warnings 

FOR YOUR SAFETY 
■■■■■■■■■■■■■■   <JR2000N Series>   ■■■■■■■■■■■■■■ 
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FOR YOUR SAFETY 

 ■■■■■■■■■■■■■■   <JR2000N Series>   ■■■■■■■■■■■■■■ 

Warnings 

Regularly check that the emergency stop switch works properly. 
For models with I/O-S circuits, also check that they work properly. 
Failure to do so may lead to danger since the robot cannot be stopped 
immediately and safely. 

Keep the emergency stop switch within reach of an operator while 
teaching and running the robot. 
Failure to do so may lead to danger since the robot cannot be stopped 
immediately and safely. 

Be sure to unplug the power cord from the wall outlet if the robot will 
remain unused for long periods of time. 
Gathered dust could lead to fire. 
 

Be sure to use power in the proper voltage range. 
Failure to do so may result in fire or malfunction. 
 

Keep the unit and the power cables away from water and oil. 
Failure to do so may result in electric shock or fire. 
IP Protection Rating is “IP30.” (“IP40” for CE specification) 

 
Use the robot indoors where no flammable or corrosive gas is present. 
Emission and accumulation of such gasses could lead to fire. 

Be sure to check grounding. 
Improper grounding may cause malfunction or defect. 

Turn off the unit before inserting and removing cables. 
Failure to do so may result in electric shock, fire, or malfunction of the unit. 
IP Protection Rating is “IP30.” (“IP40” for CE specification) 
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FOR YOUR SAFETY 

 ■■■■■■■■■■■■■■   <JR2000N Series>   ■■■■■■■■■■■■■■ 

 

Warnings 

Use the robot in an environment where it is not exposed to direct 
sunlight.  
Failure to do so may result in malfunction or defect. 

Use the robot in an environment between 0 to 40 degrees centigrade  
with a humidity of 20 to 90 percent without condensation. 
Failure to do so may result in malfunction. 
IP Protection Rating is “IP30.” (“IP40” for CE specification) 
 

Use the robot in an environment where no electric noise is present. 
Failure to do so may result in malfunction or defect. 

Be sure to confirm that tools such as the electric screwdriver unit, etc. 
are properly connected. 
Failure to do so may result in injury or defect. 

Check the mounting screws regularly so that they are always firmly 
tightened. 
Loose screws may cause injury or defect. 
 

Be sure to check the wiring to the main unit. 
Improper wiring may cause malfunction or defect. 

 

Be sure to secure the movable parts of the robot before transportation. 
Failure to do so may result in defect or injury. 
 

Do not bump or jar the unit while it is being transported or installed. 
This can cause defects. 
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 FOR YOUR SAFETY 

 ■■■■■■■■■■■■■   <JSR4400N Series>   ■■■■■■■■■■■■■■ 

 

Power the unit only with the rated voltage. 
Excessive voltage can cause fire or malfunction of the unit. 

Warnings 

Keep the emergency stop switch within reach of an operator while 
teaching and running the robot. 
Failure to do so may cause danger since the robot cannot be stopped 
immediately and safely. 

Regularly check that the I/O-S circuits and emergency stop switch work 
properly. 
Failure to do so may cause danger since the robot cannot be stopped 
immediately and safely. 

Do not leave the robot plugged in (power cord and connectors) when it is not 
in use for long periods of time. Dust can cause fire. 
Be sure to shut off the power supply before removing the power cord. 

Check the mounting screws regularly so that they are always firmly 
tightened. 
Loose screws may cause injury or defect. 

Do not sprinkle water or oil on the robot, control box, or power cord. 
Contact with water or oil can cause electric shock, fire, or malfunction of the 
unit. IP Protection Rating is “IP40.” 
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  FOR YOUR SAFETY 

 ■■■■■■■■■■■■■■   <JSR4400N Series>   ■■■■■■■■■■■■■ 

 ■ INSTALLATION ■  

Warnings 
Always use a safety barrier. 
A person entering the robot’s maximum operating range may be injured. 
At the entry/exit gate of the safety barrier, install an interlock that triggers 
an emergency stop when the gate is opened. Ensure there is no other 
way of entering the restricted area. Furthermore, put up a “No Entry” or 
“No Operating” warning sign in a clearly visible position. 

Install a safety barrier of adequate strength so as to protect the 
operator from moving tools and flying objects.  
Always use protective wear (helmet, protective gloves, protective glasses, 
and protective footwear) when going inside the safety barrier. 

Take adequate precautions against objects the robot is gripping flying or 
falling off taking into account the object’s size, weight, temperature and 
chemical composition. 

<Example> 
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  FOR YOUR SAFETY 

 ■■■■■■■■■■■■■■   <JSR4400N Series>   ■■■■■■■■■■■■■ 

 ■ INSTALLATION ■  

Confirm that the unit is properly grounded. Power supply earth should be 
connected complying with Type D installation (under 100 Ω of resistance.) 
Insufficient grounding can cause electric shock, fire, malfunction, or defect of 
the unit. 

Do not attempt to disassemble or modify the robot. 
Disassembly or modification may cause electric shocks or fire. 

Do not use the unit where flammable or corrosive gas is present. 
Leaked gas accumulated around the unit can cause fire or explosion. 

Do not block the air intake on the lower part of the back of the robot (18mm 
above the floor.) This may cause overheating or fire. 

Plug the power cord into the wall outlet firmly. 
Incomplete insertion into the wall outlet makes the plug hot and can cause fire. 
Check that the plug is not covered with dust. 
Be sure to shut off the power supply before connecting the power cord to the 
robot. 

Be sure to use within the voltage range indicated on the unit. 
Failure to do so may cause electric shock or fire. 

Place the unit in a well-ventilated area for the health and safety of the 
operator. 

Turn off the unit before inserting and removing cables. 
Failure to do so may result in electric shock, fire, or malfunction of the unit. 

Warnings 

Place the unit on a suitable flat surface that can support its weight. 
Placing the unit on an insufficient or unstable surface may cause the unit to fall, 
overturn, or breakdown. This could result in operator injury. 
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  FOR YOUR SAFETY 

 ■■■■■■■■■■■■■■   <JSR4400N Series>   ■■■■■■■■■■■■■ 

 ■ INSTALLATION ■  

Warnings 

Keep the emergency stop switch within reach of an operator. 
Failure to do so may cause danger since the robot cannot be stopped 
immediately and safely. 

Be sure to check the wiring to the main unit. 
Improper wiring may cause malfunction or defect. 

Failure to do so may result in injury or defect. 

Be sure to confirm that tools such as the electric screwdriver unit, etc. 
are properly connected. 

Failure to do so may result in malfunction or defect. 

Use the robot in an environment where it is not exposed to direct 
sunlight. 

This can cause defects. 
Do not bump or jar the unit while it is being transported or installed. 

Be sure to secure the movable parts of the robot before transportation. 
Failure to do so may result in defect or injury. 
 

Failure to do so may result in malfunction or defect. 
Use the robot in an environment where no electric noise is present. 

Failure to do so may result in malfunction. IP Protection Rating is “IP40.” 

Use the robot in an environment between 0 to 40 degrees centigrade 
with a humidity of 20 to 90 percent without condensation. 

Be sure to confirm that all the air tubes are connected correctly and 
firmly. 
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  FOR YOUR SAFETY 

 ■■■■■■■■■■■■■■   <JSR4400N Series>   ■■■■■■■■■■■■■ 

 ■ INSTALLATION ■  

 

 

 

 
Be sure to shut off the power supply before plugging the power cord. 

Warnings 

 
Place the operation box on a flat surface more than 80 cm above the floor 
so that it is easier to operate it. 

Use the unit in an environment that is not dusty or damp. 
Dust and dampness may cause defect or malfunction. 
IP Protection Rating is “IP40.” 
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  FOR YOUR SAFETY 

 ■■■■■■■■■■■■■■   <JSR4400N Series>   ■■■■■■■■■■■■■ 

 ■ WORKING ENVIRONMENT ■  

Warnings 
When you lubricate or inspect the unit, unplug the power cord from the 
robot. 
Failure to do so may result in electric shock or injury. 
Be sure to shut off the power supply before removing the power cord from 
the robot. 

When going inside the safety barrier, place a “Do Not Operate” sign on the 
start switch. 

Keep the emergency stop switch within reach of an operator while 
teaching and running the robot. 
Failure to do so may cause danger since the robot cannot be stopped 
immediately and safely. 

Install a safety barrier of adequate strength so as to protect the operator from 
moving tools and flying objects.  
Always use protective wear (helmet, protective gloves, protective 
glasses, and protective footwear) when going inside the safety barrier.

Be sure to confirm that all the air tubes are connected correctly and 
firmly. 

Always watch out for robot's movement, even in the teaching mode. 
Special attention will protect the operator from injury. 
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  FOR YOUR SAFETY 

 ■■■■■■■■■■■■■■   <JSR4400N Series>   ■■■■■■■■■■■■■ 

 ■ DURING OPERATION ■  

Warnings 
When operations are taking place within the safety barrier, ensure no one 
enters the robot’s maximum operating range. 

If you must go inside the safety barrier, be certain to push the emergency 
stop switch and put a “Do Not Operate” sign on the start switch. 

When starting the robot, check that, no one is within the safety barrier and 
no object will interfere with the robot operating. 

Under no circumstances should you go inside the safety barrier or place 
your hands or head inside the safety barrier while the robot is operating. 

Keep the emergency stop switch within reach of an operator while 
teaching and running the robot. 
Failure to do so may cause danger since the robot cannot be stopped 
immediately and safely. 

If anything unusual (e.g. a burning smell) occurs, stop operation and 
unplug the cable immediately. Contact your dealer or the office listed 
on the last page of this manual.  
Continuous use without repair can cause electric shock, fire, or breakdown 
of the unit. 
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  FOR YOUR SAFETY 

 ■■■■■■■■■■■■■■■   <JS/JSG Series>   ■■■■■■■■■■■■■■ 

 

Warnings 

Change the robot battery periodically (approximately every three years) 
to prevent malfunction or breakdown. 

Keep the emergency stop switch within reach of an operator while 
teaching and running the robot. 
Failure to do so may cause danger since the robot cannot be stopped 
immediately and safely. 

Regularly check that the I/O-S circuits and emergency stop switch work 
properly. 
Failure to do so may cause danger since the robot cannot be stopped 
immediately and safely. 

Be sure to unplug the power cord from the robot if it will remain unused for 
long periods of time. Gathered dust could lead to fire. 
Be sure to shut off the power supply before removing the power cord. 
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  FOR YOUR SAFETY 

 ■■■■■■■■■■■■■■■   <JS/JSG Series>   ■■■■■■■■■■■■■■ 

 

Warnings 
Check the mounting screws regularly so that they are always firmly 
tightened. 
Loose screws may cause injury or defect. 

Power the unit only with the rated voltage. 
Excessive voltage can cause fire or malfunction of the unit. 

Do not sprinkle water or oil on the robot, control box, or power cord. 
Contact with water or oil can cause electric shock, fire, or malfunction of the 
unit. IP Protection Rating is “IP40.” 
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  FOR YOUR SAFETY 

 ■■■■■■■■■■■■■■■   <JS/JSG Series>   ■■■■■■■■■■■■■■ 

 ■ INSTALLATION ■  

Warnings 
Always use a safety barrier. 
A person entering the robot’s maximum operating range may be injured. 
At the entry/exit gate of the safety barrier, install an interlock that triggers 
an emergency stop when the gate is opened. Ensure there is no other 
way of entering the restricted area. Furthermore, put up a “No Entry” or 
“No Operating” warning sign in a clearly visible position. 

<Example> 

Install a safety barrier of adequate strength so as to protect the 
operator from moving tools and flying objects.  
Always use protective wear (helmet, protective gloves, protective glasses, 
and protective footwear) when going inside the safety barrier. 

Take adequate precautions against objects the robot is gripping flying or 
falling off taking into account the object’s size, weight, temperature and 
chemical composition. 
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  FOR YOUR SAFETY 

 ■■■■■■■■■■■■■■■   <JS/JSG Series>   ■■■■■■■■■■■■■■ 

 ■ INSTALLATION ■  

Confirm that the robot is properly grounded. Power supply earth should be 
connected complying with Type D installation (under 100 Ω of resistance.) 
Insufficient grounding can cause electric shock, fire, malfunction, or defect of the 
unit. 

Do not attempt to disassemble or modify the robot. 
Disassembly or modification may cause electric shocks or fire. 

Install the robot in a place which can endure its weight and conditions 
while running. 
Placing the unit in an insufficient or unstable surface may cause the unit to fall, 
overturn, or breakdown. This could result in operator injury. 
Be sure to leave a space of at least 30cm between the back of the robot 
(equipped with a cooling fan) and the wall. Insufficient space can lead to 
overheating or fire. 

Plug the power cord into the wall outlet firmly. 
Incomplete insertion into the wall outlet makes the plug hot and can cause fire.
Check that the plug is not covered with dust. 
Be sure to shut off the power supply before connecting the power cord to the 
robot. 

Power the unit only with the rated voltage. 
Excessive voltage can cause fire or malfunction. 

Do not use the unit where flammable or corrosive gas is present. 
Leaked gas accumulated around the unit can cause fire or explosion. 

Place the unit in a well-ventilated area for the health and safety of the 
operator. 

Turn off the robot before inserting and removing cables. 
Failure to do so may result in electric shock, fire, or malfunction. 

Warnings 
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  FOR YOUR SAFETY 

 ■■■■■■■■■■■■■■■   <JS/JSG Series>   ■■■■■■■■■■■■■■ 

 ■ INSTALLATION ■  

Warnings 
Be sure to confirm that all the air tubes are connected correctly and 
firmly. 

Use the robot in an environment between 0 to 40 degrees centigrade 
with a humidity of 20 to 90 percent without condensation. 
Failure to do so may result in malfunction. IP Protection Rating is “IP40.” 

Use the robot in an environment where no electric noise is present. 
Failure to do so may result in malfunction or defect. 

Be sure to secure the movable parts of the robot before transportation. 
Failure to do so may result in defect or injury. 

 

Do not bump or jar the unit while it is being transported or installed. 
This can cause defects. 

Use the robot in an environment where it is not exposed to direct 
sunlight. 
Failure to do so may result in malfunction or defect. 

Be sure to confirm that tools such as the electric screwdriver unit, etc. 
are properly connected. 
Failure to do so may result in injury or defect. 

Be sure to check the wiring to the main unit. 
Improper wiring may cause malfunction or defect. 

Keep the emergency stop switch within reach of an operator. 
Failure to do so may cause danger since the robot cannot be stopped 
immediately and safely. 
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 FOR YOUR SAFETY 

 ■■■■■■■■■■■■■■■   <JS/JSG Series>   ■■■■■■■■■■■■■■ 

 ■ INSTALLATION ■  

 
Be sure to shut off the power supply before plugging the power cord. 

Warnings 

Be sure to remove the eye bolt after installing the robot so that it does 
not hit the arm. 
Failure to do so may result in injury or breakdown of the unit. 

Place the control box on a flat surface more than 80 cm above the floor so 
that it is easier to operate it. 

Use the robot in an environment that is not dusty or damp. 
Dust and dampness may cause malfunction or defect. IP Protection Rating 
is”IP40.” 
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 FOR YOUR SAFETY 

 ■■■■■■■■■■■■■■■   <JS/JSG Series>   ■■■■■■■■■■■■■■ 

 ■ WORKING ENVIRONMENT ■  

Warnings 
When you lubricate or inspect the unit, unplug the power cord from 
the control box. 
Failure to do so may result in electric shock or injury. 
Be sure to shut off the power supply before removing the power cord 
from the control box. 

When going inside the safety barrier, place a “Do Not Operate” sign on the 
start switch. 

During operation, always have the emergency stop switch within the 
operator’s reach. 
Failure to do so may cause danger since the robot cannot be stopped 
immediately and safely. 

Install a safety barrier of adequate strength so as to protect operators from 
moving tools and flying objects. 
Always use protective wear (helmet, gloves, glasses, and footwear) 
when going inside the safety barrier. 

Be sure to confirm that all the air tubes are connected correctly and 
firmly. 

Always watch out for robot's movement, even in the teaching mode. 
Special attention will protect the operator from injury. 
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 FOR YOUR SAFETY 

 ■■■■■■■■■■■■■■■   <JS/JSG Series>   ■■■■■■■■■■■■■■ 

 ■ DURING OPERATION ■  

Warnings 
When operations are taking place within the safety barrier, ensure no one 
enters the robot’s maximum operating range. 

If you must go inside the safety barrier, be certain to push the emergency 
stop switch and put a “Do Not Operate” sign on the start switch. 

When starting the robot, check that, no one is within the safety barrier and 
no object will interfere with the robot operating. 

Under no circumstances should you go inside the safety barrier or place 
your hands or head inside the safety barrier while the robot is operating. 

Keep the emergency stop switch within reach of an operator while 
teaching and running the robot. 
Failure to do so may cause danger since the robot cannot be stopped 
immediately and safely. 

If anything unusual (e.g. a burning smell) occurs, stop operation and 
unplug the cable immediately. Contact your dealer or the office listed on 
the last page of this manual.  
Continuous use without repair can cause electric shock, fire, or breakdown of 
the unit. 
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PREFACE 
                       

 

The “JR C-Points” is an enhanced version of the existing PC software, JR Points. 
This software will help you to operate the JS series SCARA robot and the JR2000N series robot.  Its 
features are affordable price, cost efficiency, diverse applications, high speed, rigidity and precision.  
Furthermore, it can accommodate a wide variety of requirements. 
 
By using the “JR C-Points”, you can save, read, add, insert, delete, or edit C&T data, and can also 
perform JOG teaching operations via PC.  You can also register programs via PC, without connecting 
the teaching pendant.  
 
This operation manual explains how to use the “JR C-Points” software.   
 
Operating methods such as clicking the mouse and use of dialog boxes for “JR C-Points” are the 
same as those of Microsoft Windows® 2000 applications. 
For details of Windows® 2000 operating methods, refer to the instruction manual supplied with 
Windows® 2000. 
 

 

 

 

 

 
When transmitting C & T data between the PC and the robot,  
be sure to save the data in a file for backup. Warning 

 

 

 

 

 

 

 

 

5.00E 

 
Windows, Excel, Word are registered trademarks of Microsoft Corporation. 
Lotus 1-2-3 is a registered trademark of Lotus Development Corporation. 
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HARDWARE REQUIREMENTS 
                       

 

To operate the “JR C-Points”, “JR C-Points Limited Edition (included in the JR2000N or JS Series 
Operation Manual CD-ROM)” software on your PC, the following is required. 
 

 

 

● Personal Computer 
Should be configured for use with Windows® 2000/XP. 

 

 

● Memory Capacity 
A minimum of 32 MB of memory is required to operate the “JR C-Points” or “JR C-Points 
Limited Edition” normally. 

 

 

● Operating System 
Microsoft Windows®2000/XP 

 

 

● Hard Disk Capacity 
A minimum of 20 MB of hard disk space is required after installing Windows® 2000/XP. 

 

 

● COM Port 
One vacant COM port is required to connect the robot to the PC. 

 

 

 

The required memory capacity or hard disk space may vary depending on the system environment. 
Insufficient hard disk space may cause insufficient memory or trouble while operating. 
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CONNECTION 
                       

 

To transmit teaching data to the robot from the PC, connect the two with an RS-232C straight cable 
(as illustrated below.) 
For details of the communication cable wiring, refer to Page 57. 
 

 

Refer to the instruction manual 
supplied with your PC. 
 

RS-232C 

 

Straight 

[PC] [Robot] 
9-pin  

 

 

 

Connect one end of the RS-232C cable to the RS-232C connector on the robot (on the control box for 
the JS series, on the robot body for the JR 2000N series) and the other end to the COM port (serial 
connector/RS-232C) on the PC. 
When operating the robot via the PC, be sure to disconnect the teaching pendant from the control box 
and connect a grip switch to the teaching pendant connector instead. 
 

When operating the robot via the PC, 
JS Series: Be sure to disconnect the teaching pendant and connect a grip switch to the teaching 

pendant connector instead. 
JR2000N Series: Be sure to disconnect the teaching pendant. (If you use a teaching pendant with an 

enable switch and an emergency stop switch, connect a grip switch to the teaching 
pendant connector.) 

 
Be sure to turn off the power to the PC and the robot before inserting 
or removing the cable. 

 

 

 

 

■ JR2000N Series 

COM1 

Teaching Pendant Connector (TPU) 

<Body Front> 

 

 

 

 

 

 

PC Operation                                                JS/JSR4400N SCARA Robot 
JSG GANTRY Robot 

JR2000N Desktop Robot  

2



 

■ JS Series 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

                            <Control Box (rear)> 

COM1 

Teaching Pendant 
Connector (TPU) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                <Control Box (front)> 
 

 When operating the robot via the PC, be sure to disconnect the teaching pendant from the 
control box and connect a grip switch to the teaching pendant connector instead. (If you use a 
teaching pendant without an enable switch and an emergency stop switch in the JR 2000N 
series, it is not necessary to connect a grip switch. 
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Enable Switch 

Emergency Stop Switch  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                      <Grip Switch> 
 

 

 

 If you use a teaching pendant with an enable switch but without an emergency stop switch with 
the JR2000N series, use a grip switch with an emergency stop switch only.  If you use a 
teaching pendant with an emergency stop switch but without an enable stop switch, use a grip 
switch with an enable switch only. 
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INSTALLATION AND UNINSTALLATION 

                       

 

Install the “JR C-Points” software onto your PC before operation. 
 

■ INSTALLATION 
1. Start Windows® and check that it is functioning correctly.  Before installation, close all    

applications. 
2. Insert the “JR C-Points” CD-ROM into the CD-ROM drive. 
3. The installer automatically starts up.  Follow the onscreen instructions.  
 
If the Installer Doesn’t Start up Automatically, 

1. Select the CD-ROM drive from My Computer in Windows® Explorer. 
2. Double-click “¥SETUP.EXE” under the CD-ROM drive. 
3. Follow the onscreen instructions. 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Enter the serial number affixed to the back of the CD-ROM case in one-byte characters. 
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■ UNINSTALLATION 
1. Start up Windows® and check that it works properly.  Close all open applications. 
2. Insert the “JPTaS System” CD-ROM into the CD-ROM drive. 
3. Installer starts up automatically.  If it does not start up, click the CD-ROM drive in Windows® 

Explorer or My Computer. 
4. Follow the onscreen instructions.  If this application has already been installed, starting up 

Installer will execute uninstalled. 
 

 To upgrade your application, start up Installer to uninstall the existing application, and start up 
Installer again to install a new one. 
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START AND EXIT 
                       

■ Start 
Use one of the following two methods to start up the “JR C-Points” software. 
1.  Select [Program] from the [Start] menu of Windows® and click [JR C-Points.]  

[Shortcut Icon] 

2.  Click the shortcut icon on the desktop. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The JR C-Points can be started even when the PC and the robot are not connected or when the 
power to the robot is OFF. 
However, a “communication error” will be returned and information stored in the robot will not be 
read out to the PC.  Set the “Model Name”, “Axis Info” (number of Axis) and the IO type (I/O-SYS 
function assignments depend on whether “IO-A” or “IO-B” is selected.) of your robot and click [OK.] 
In this case, you cannot operate the robot via the PC. 
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■ Exit 
Use one of the following two methods to exit the “JR C-Points” software. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Click [Exit] on the [File] pull-down menu. 
 

or 
 

• Click the    (Exit) button on the upper right corner of the screen. 
 

 

 

If unsaved C&T data is open, the Exit confirmation dialog box will appear. 
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SCREEN 

                       

 

Tool BarC&T Data File Name         Menu Bar 
      Pull-Down Menu                      Program Number and Name 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

          Point Data Item 
Status Bar                        Model Name and Axis Info. 
 

 

 

C&T Data File Name: Name of the currently open C&T data file 
Menu Bar: “JR C-Points” menu: Click an item to display a pull-down menu. 

Tool Bar: Shortcut icon alignment 
Pull-Down Menu: Appears when clicking an item on the menu bar. 

Program Number and Name: Number and name of the currently open (selected) program 
Point Data Item: Items can be set to point data 

Status Item: Describes the PC status. 
Model Name and Axis Info: Model name and Axis of the robot connected to the PC 
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■ Icon Functions 
 

Icon Function Similar Menu Item 

 Open a new (C&T data) file. File – New 

 Open an existing file. File – Open 

 Overwrite the currently open file. File – Save As 

 Print File – Print  

 Cut the currently selected point. Edit – Cut 

 Copy the selected cell to the clipboard. Edit – Copy 

 Paste the clipboard contents to the cell. Edit – Paste 

 Redisplay View – Refresh 

 Display the “JR C-Points” version information.  Help – Version Information 

 Add a (PTP) point to the end of the program. Edit – Add Point 

 Insert a (PTP) point.  Edit – Insert Point 

 Delete a point. Edit – Delete Point 

 Add a PTP point to the end of the program.  

 Add a CP start point to the end of the program.  

 Add a CP passing point to the end of the program.  

 Add a CP stop point to the end of the program.  

 Add a CP arc point to the end of the program.  

 Add a CP end point to the end of the program.  

 Add a PTP evasion point to the end of the program.  

 

Turn the motor power to the robot ON. (JS Series) 
Execute mechanical initialization of the robot. 
(JR2000N Series) 

Robot – Motor Power ON 
Robot – Mechanical Initialization 

 Operate the robot in JOG mode. Robot – JOG 

 
The robot executes a “GO MOVE” operation. 
(To change settings of a point)  Robot – Go Move  

 
The robot executes a “GO plus MOVE” operation. 
(To confirm settings of a point) Robot – Go Plus Move 

 The robot executes a point playback. Robot – Point Playback 

 The robot executes a test run. Robot – Test Running  

 Add a program. Program – Add Program 

 Delete the currently selected program. Program – Delete Program 

 

 Click [Toolbar] on the [View] pull-down menu to display or hide the icons. 
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OPERATION PROCESS 
                       

 

The following chart shows the process for creating C&T data with this application and sending the 
data to the robot. 
 

 

 

 

 

 

                            *1 
 

 

 

 

 

 

 

 

 

                               *2 

Receive 
from the robot 

Open File New 

Change 
C&T data 

Save File 

(Backup) 

Send 
C&T data 

to the robot 

Open 
C&T data 

Open 
C&T data 

Open 
C&T data 

 

 

 

 

 

 

 

 

 

 

 

*1: In this case, “file” indicates the extension “.cps” file stored in the PC. 
*2: Before sending C&T data to the robot, be sure to back up the data to a file in case of 

communication error. 

PC Operation                                                JS/JSR4400N SCARA Robot 
JSG GANTRY Robot 

JR2000N Desktop Robot  

11



 

C&T DATA 

                       

 

This section explains the C&T data handled with this application.  “C&T” stands for Customizing and 
Teaching data. 
In this application, the teaching data is always handled (e.g. File Open, Save File, Send to Robot, 
Receive from Robot) in combination with the customizing data.  The unit of data is called “C&T data.”  
You cannot save, receive and send only the teaching data or only the program. 
Only one unit of C&T data can be saved in the robot at one time.  Accordingly, if you send the 
C&T data from the PC to the robot, the data stored in the robot will be overwritten (deleted.)   
 

 

 
C&T data 

 
Customizing 

data 

 
Teaching data 

 

 

 

 

 

 

 

 

 

 

The C&T data contains all the setting values and data stored in the robot except the settings below.   
(You cannot change the settings below by PC.) 
When changing any of the settings except the following or creating and editing any program or point 
job data, open the C&T data first. 
 

 Teaching Environments Setting 
(Settings displayed by pressing the  T.ENV  key on the teaching pendant） 

 
 Administration Settings 

• Start Channel 
• Program Number Change Invalid 
• COM Setting 
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NEW 

                       

 

 

Click [New] on the [File] pull-down menu. 
 

The new C&T data file will open.   
In this case, no contents are displayed on the screen 
since no program is open. 
 

A new C&T data file opens when the application is 
started up. 
 

 

 

 

 

 

 

 

 

 

 

 You cannot open multiple units of C&T data at one time.  If a C&T data file is already open, 
close it before opening a new C&T data file. 
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OPEN/SAVE 
                       

 

This section explains how to open or save to a C&T data file in the PC.  To change or open the C&T 
data in the robot, refer to the “Communication” section on page 16.  
Before sending the C&T data to the robot, back up the data to a file in case of error. 
 

 

 

■ Save to (.cps) File 
 

Click [Save] or [Save As] on the [File] pull-down menu.   
 

When saving the data in a file, if any setting value 
included in the C&T data exceeds the entry range, the 
upper/lower value of the range is saved instead.  
However, if a sequencer program number and a point 
data or additional function data number assigned to 
the point data exceeds the entry range, “0” (meaning 
“not registered”) is saved. 
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■ Open (an Extension “.cps”) File 
 

1. Click [Open] on the [File] pull-down menu.   
You cannot open multiple units of C&T data at one time.  If a C&T data file is already open, 
close it before opening a new C&T data file. 

 
2. Select a file to be opened. 
 

 

 

 

■ Read JCS File (an Extension “.cps” File) 
You can convert a CAD drawing (DXF file) into a JCS file using the Dxf2Robot software and read it. 

 
1. Click [Import] on the [File] pull-down menu. 
 
2. Select a file to be opened. 

The JCS file length is not fixed.  Select the unit of length (mm/inch) here. 
 

3. Select a number for the data included in the JCS file (a program number from the C&T data) and 
click [OK.] 

 
If the C&T Data Is Not Open 
The screen displays new C&T data which contains only one (selected) program. 

 
If the C&T Data Is Already Open 
The screen displays that a new (selected) program has been added to the currently open C&T 
data. 

 

 

 Once opened, a JCS file cannot be saved again unless converted into a (.cps) C&T data file. 
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COMMUNICATION 

                       

 

Before using created C&T data, it has to be transmitted to the robot.  To open the C&T data file 
currently being used in the robot, it has to be transmitted to the PC. 
 
When using this application, all data is handled in the unit (C&T data) described in the previous 
section.  You cannot send or receive a specific program or specific point data even when transmitting 
data between the PC and the robot. 
 

 

 Be sure to send, receive, or read information between the robot and the PC under the 
following conditions. 

 
• Teaching base condition 

(The point setting screen or new position entry screen is displayed in the teaching mode.) 
• Wait for start condition 

(The robot is waiting for start at the work home position either in the run or external run mode.)  
• Customizing mode base condition 

(The customizing mode menu screen is displayed.) 
• Administration mode base condition 

(The administration mode menu is displayed.) 
 

 

 

 

 

■ How to Receive Data 
Click [Receive C&T Data] [Robot] on the [Robot] pull-down menu. 
The robot will start to send the C&T data to the PC.  When the transmission is complete, the received 
C&T data will open. 
 

 You cannot open multiple units of C&T data at one time.  If C&T data is already open, close it 
before receiving new C&T data. 
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■ How to Send Data 
Click [Send C&T Data] on the [Robot] pull-down menu. 
The PC will start to send the C&T data to the robot. 
When sending data, if any setting value included in the C&T data exceeds the entry range, the 
upper/lower value of the range is transmitted instead.  However, if a sequencer program number or a 
point job data or additional function data number assigned to the point data exceeds the entry range, 
“0” (meaning “not registered”) is transmitted. 

 
 
 Only one unit of the C&T data can be saved in the robot at one time.  Accordingly, if you 

send C&T data from the PC to the robot, the data stored in the robot will be overwritten 
(deleted.)  To save data stored in the robot in a file, close the data file to be transmitted 
briefly and click [Receive C&T Data.]  

 When transmitting C&T data while logged in, the PC will log out if the data does not contain the 
account you are logged in under.   
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COMMUNICATION SETTING 

                       

 

This section explains how to set communication parameters. 
When sending or receiving data between the robot and the PC, select a COM Port for the PC and 
match the communication parameters of the PC and the robot.  
You cannot confirm or set the communication parameters for the robot via PC. 
 

 

■ PC Communication Parameters 
 

Click [COM Status] on the [Robot] pull-down menu.   
Set up or confirm the communication settings for the PC. 
 

 

Select the same [COM Port] number as that of the 
connector on the PC connected to the robot. 
 

For the PC COM Port number, refer to the instruction 
manual for your PC. 
 

Set or confirm each parameter setting other than the 
[COM Port] number to match that of the robot. 
 

 

 

 This setting is valid only for communication with this application. 
 

 

 

 

 

      COM1                            

 

 

 

            Robot                       PC 

COM2 
COM1 

COM4 
COM3 
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■ Robot Communication Parameters 
 

You cannot confirm or set the communication parameters for the robot via the PC. 
To confirm or set the communication parameters for the robot, connect the teaching pendant to the 
control box. 
 

 

Start the robot in the Administration mode.   
 

Select [Administration Settings Mode] from the 
Administration menu.   

 
Select [COM Setting] from the Administration 
Settings Mode menu to display the COM 
Setting screen. (See right)   
 

 

 

 

 

 

 

Select [COM1 Communication Setting] to 
display the COM1 communication settings. 
(See right)     

 
Confirm that each parameter setting matches 
the PC communication parameters.   
 

 

 

 

              COM Setting               
COM1 Communication Setting 
COM2 Communication Setting             
COM3 Communication Setting             
 

 

 

 

 

 

 

 

 

      COM1 Communication Setting       
Baud Rate                          9600 
Character Length                     8 bit 
Stop Bit                             1 bit 
Parity                               None 
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CONNECTION CONFIRMATION 
SYSTEM INFORMATION 

                       

 

Click [Robot] on the menu bar and then click 
[SystemInfo] on the pull-down menu. 
Information about the robot connected will be 
read out. 
 

 “Robot System Software Ver. Number” 
is the system version number built into 
the robot, not the version number of 
“JR C-Points.” 

 

The “System Information” function can be 
used to confirm the connection between the PC and the robot.  Try this when communication with the 
robot fails or when the robot cannot be operated.  If the system information cannot be read out, 
confirm the following.  If the system information still cannot be read out, try [Diagnosis Mode] 
(teaching pendant required) or contact your dealer. 
 

 

 

 

 

 

Each communication 
parameter is same. 

The power to the 
robot is ON. 

The cable is 
connected 

<Unable to Connect> 

RS-232C cable 
is used. 

 Confirm that the “COM Port” number set in the 
“COM Status” is the same as the COM Port number 
of the PC connected to COM1 of the robot. 

 
 Confirm that “COM1 Communication Settings” for 

the robot are the same as the “COM Status” for the 
PC (except for the “COM Port” number.) 
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SCREEN DISPLAY 
                       

 

This section explains how to change or restore the screen display. 
Click [View] on the menu bar to display the following pull-down menu. 
 

 

■ Tool Bar 
Click this to display or to hide the tool bar.   
 

 

■ Status Bar 
Click this to display or to hide the status bar.   
 

 

■ Refresh 
Click this to redisplay the point data. 
If any setting value included in the data exceeds the entry range, the upper/lower value of the range is 
displayed instead.  However, if a sequencer program number and point data or additional function 
data number assigned to the point data exceeds the entry range, “0” (meaning “not registered”) is 
displayed. 
 

 

■ Change View 
Click this to select the point data display, horizontal or vertical.   
 

 

■ Unit System 
Click this to select the unit of length or coordinates from the following. 

• mm (millimeter) 
• in (inch) 

 
 

■ Set View Language 
Captions created in customizing mode can be displayed in a specified language. 
If a caption is not set with specified language, it will be displayed in English. 
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TEACHING DATA – PROGRAM 

                       

 

■ Open Program 
A program is a part of the C&T data.  To open a program, open C&T data first.   
 

 

• New Program 
To open a new program, click [Add Program] on the [Program] pull-down menu.  The following dialog 
box will appear.  Select a new program number to be registered and enter a name.  You can use up 
to ten one-byte characters.   
 

You cannot select a program number that is already 
registered. 
 

 

 

 

 

• Existing Program 

Click the “▼” mark on the right of the program name display. (See below)  The list of programs 
included in the C&T data will be displayed.  Select the desired program to be opened.   
 

                        Program Number    Program Name 
 

 

 

 

 

 

 

 

 

 

You can also display the program list and select the desired program by clicking [Program] on the 
menu bar and [Program Change] on the pull-down menu.   
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■ Program Data 
When a new program is opened, the following dialog box will be displayed.  Click a tab to enter or 
select a desired value.  After entering the value, click [OK.]   
This dialog box can also be viewed by clicking [Program Data] on the [Program] pull-down menu. 
 

                               Tab 
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■ Point Data 
After opening a program using [Add Program], the point data alignments will be blank. 
To register more than one point in a program, repeat [Add Point] as many times as required.   
 

           Point Data Item                 Point Data 

                       Cell 
 

• Enter/Change a Value 
Click a cell and enter a value to be registered using the keyboard.   
In the [Type] line, the “▼” mark will appear on the right of the cell when a cell is clicked.  Click this to 
display the list of point types.  Select the point type to be registered.   
 
 
• Edit 
Select a cell or point to be edited and click [Edit] on the menu bar.  The Edit menu will appear. 
This menu also appears by selecting a cell or point to be edited and right-clicking it.   
To select a point, select all cells included in the point (except the point number line) or click the point 
number. 
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• Cut 
The [Cut] operation is executed in points. 
Select a cell and click [Cut] on the [Edit] pull-down menu.  The point including the selected cell will be 
deleted.   
After the [Cut] operation, select a cell and click [Paste] on the [Edit] pull-down menu.  The clipped 
point will be inserted in front of the selected cell.   

 
• Copy 
Cell: Select a cell as copy source and click [Copy] on the [Edit] pull-down menu.  Then select a cell 

as copy destination and click [Paste] on the [Edit] pull-down menu.  The copy source cell will be 
overwritten onto the copy destination cell. 

Point: Select a point as copy source and click [Copy] on the [Edit] pull-down menu.  Then       
select a point as copy destination and click [Paste] on the [Edit] pull-down menu.  The copied 
point will be inserted in front of the point where the cursor is blinking.   

Click [Paste After Last Point] to add the copied program to the end of the program.   
 
• Paste/Paste After Last Point 
By using these functions, you can paste not only the “clipped” or “copied” cell and point but also data 
created by other applications, such as Lotus 1-2-3, Microsoft Excel®, and Word®.     
 
• Add Point 
Click [Add Point] on the [Edit] pull-down menu.  A point will be added to the end of the point data 
alignments.  
 
• Insert Point 
Click [Insert Point] on the [Edit] pull-down menu.  A point will be inserted in front of the point data 
where the cursor is blinking. 
 
• Delete Point 
Click [Delete Point] on the [Edit] pull-down menu.  The point data where the cursor is blinking will be 
deleted. 
 
 
 

 The [Add Point], [Insert Point], and [Delete Point] operations also can be executed by clicking 
the icons in the tool bar. 

 

PC Operation                                                JS/JSR4400N SCARA Robot 
JSG GANTRY Robot 

JR2000N Desktop Robot  

25



 

• Block Copy 
The [Block Copy] operation is executed in points. 
Select a cell and click [Block Copy] on the [Edit] pull-down menu.  The Block Copy dialog box will 
appear. 
Enter the range of copy source points (Start Point Number and End Point Number), copy count (Copy 
Times) and offsets (Offset X, Y, Z, R), and then click [OK.]  The copied point block will be inserted just 
behind the original block. 

 
 

• Mirror Copy (Right-Left/Front-Back) 
The [Mirror Copy] operation is executed in points. 
Select a cell and click [Mirror Copy] on the [Edit] pull-down menu.  The Mirror Copy dialog box will 
appear. 
Enter the range of copy source points (Start Point Number and End Point Number) and mirror position 
(Mirror Position X/Y), and then click [OK.]  The copied point block will be inserted just behind the 
original block. 

 
 

• Offset Move 
The [Offset Move] operation is executed in points. 
Select a cell and click [Offset Move] on the [Edit] pull-down menu.  The Offset Move dialog box will 
appear. 
Enter the range of offset move points (Start Point Number and End Point Number) and offsets (Offset 
X, Y, Z, R), and then click [OK.]   
The designated point coordinates will be converted. 

 
 

• Block Rotation 
The [Block Rotation] operation is executed in points. 
Select a cell and click [Block Rotation] on the [Edit] pull-down menu.  The Changing Rotating Position 
dialog box will appear. 
Enter the range of block rotation points (Start Point Number and End Point Number), center of rotation 
and rotation angle, and then click [OK.]   
The designated point coordinates will be converted. 

 
 

• Multiple Line Speed 
Line speed within the designated range of points can be converted in percentages.  If the converted 
value exceeds the setting range, the upper or lower value will be set instead. 
Click [Multiple Line Speed] on the [Edit] pull-down menu.  The Multiple Line Speed dialog box will 
appear.  Enter the Start Point Number, End Point Number and Line Speed Rate, and then click [OK.]     
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• Reverse Point 
Use this function to reverse the order of points within the designated range.   
Click [Reverse Point] on the [Edit] pull-down menu.  The Point Reverse dialog box will appear.  
Enter the Start Point Number and End Point Number, and then click [OK.]     

 
e. g. Start Point Number: 3, End Point Number: 5  

P1, P2, P3, P4, P5, P6    P1, P2, P5, P4, P3, P6 
 

• Transform into Relative 
Use this function to convert the point coordinates in the currently selected program to the relative 
coordinates.   

 
• 2-Points Position Conversion 
By designating two points of the conversion source and the corresponding two points of the 
conversion destination, you can execute X, Y, and Z parallel and rotational transform. 
Click [2-Points Position Conversion] on the [Edit] pull-down menu.  The 2-Points Position Conversion 
dialog box will appear.  Select the conversion range.  Enter “Source Position” and “Destination 
Position”, and then click [Calculate Amount.]  The “Converting Amount” will be calculated.  Click 
[Converting Data] to convert the data coordinates within the designated range according to the 
converting amounts.   
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Coordinate conversion data (Source Position, Destination Position, and Converting Amount) used 
here is not included in the C&T data.  Accordingly, this data can neither be transmitted between the 
PC and the robot nor be saved in a file. 
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TEACHING DATA CHANGE – POINT JOB DATA 

                       

 

Point job data is a part of the C&T data.  Before creating and editing point job data, you need to open 
the C&T data.   
 
Click [Point Job] on the [Data] pull-down menu.  The list of point job data will appear.   
                   List 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Contents of the currently selected point job data  
(No. 1 in this example) 

 

 

■ Copy 
Copy and edit existing point job data to create similar data. 
1. Select the point job data to be copied from the list and click [Copy.]  The selection or entry dialog 

box for the copy destination point job number will appear. 
2. Select or enter the copy destination point job number. 
 
 
■ Delete 
1. Select the point job data to be deleted from the list and click [Delete.] 
2. The Delete confirmation screen will appear.  Confirm that the number is correct and click [OK.] 
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■ New (Add) 
1. Click [Add] at the lower left of the list and select a point data number.  The Point Job Data Edit 

dialog box will appear.  You cannot select numbers already registered. 
 

 You can change the size of the point job data edit dialog box.  Click the “    ” button on the 
upper right corner of the dialog box to make it full-screen.  Click and drag the edge of the 
dialog box to change the size. 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Numeric Value Entry

Command Selection 

SelectionCommand Line 
Character/ Expression Entry 
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2. Select (Click) the desired command to enter or select the necessary parameters for the selected 
command. 

3. Enter or select (click) the necessary parameter(s.)  You can enter the numeric parameters using 
the keyboard. 

4. Click [Register.]  One command line will be registered and the highlight will shift to the next line. 
5. Repeat the above Steps 3 – 5 as many times as required. 
6. After entering all the commands, click [OK.] 
 
When entering the point job name, you can use up to 40 one-byte characters. 
 

 The above Steps 3 – 7 are also used when entering “Additional Function Data” and “Sequencer 
Program” commands. 

 

 

 

■ Edit 
Use this function to correct existing point data. 
1. Select the desired point job data number and click [Edit] at the bottom of the list.  The point job 

data edit dialog box will appear. 
2. After one of the following operations, click [OK.] 
 

Add a Command _  Select the last line of a command line (that contains no command) on the 
left side of the screen.  Then select (click) or enter “command” and 
“necessary parameter(s)” in the order described above.  Click [Register.]  

Insert a Command _ Select the desired command line on the left side of the screen.  Then 
select (click) or enter “command”, and “necessary parameter(s)” in the 
order described above.  Click [Register.] 
One command line will be inserted in front of the selected command line 
and the following command lines will shift downward. 

Delete a Command _ Select the desired command line on the left side of the screen and Click 
[Delete.]  The selected command line will be deleted and the following 
commands will shift upward. 

Change a Command _ After inserting a new command, delete the desired command. 
 

 The above Step 2 is also used when changing “Additional Function Data” and “Sequencer 
Program” commands. 
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TEACHING DATA CHANGE  

– ADDITIONAL FUNCTION DATA 

                       

 

Additional function data is a part of the C&T data.  Before creating and editing additional function data, 
you need to open the C&T data. 
Click [Additional] on the [Data] pull-down menu.  The Additional Function Data list will appear.  
Select the desired additional function data to be created or changed. 
 

 

 

 

 

 

 

 

 

To create new additional function data, click [Add] and select a number from the unentered number 
list. 
To change existing additional function data, select the desired data number to be changed from the list 
(see below) and click [Edit.]  The edit dialog box for the selected additional function data will appear. 
 

 

 

 

 

 

 

 

 

 

 

 

Contents of Currently Selected Data 
(No. 1 in this example)

Existing Data List 
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Click [Add] to display  
unentered number list. 

 

 

 

 

 

 

■ Edit 
To edit existing additional function data, select the desired data number to be edited from the list and 
click [Edit.]  The edit dialog box for the selected additional function data will appear. 

 
• [PTP Condition], [CP Condition], [Tool Data], [Pallet Routine], [Work Adjustment] 

Select or enter the desired item in the edit dialog box. 
You can enter a name for [Pallet Routine] and [Work Adjustment.]  Up to 10 one-byte characters 
can be used. 

• [Execute Condition] 
You can enter or change a command in the same way as you would for point job data.  Enter or 
change a command and click [OK] in the edit dialog box. 

 
 
■ Copy 
Select the desired additional function data number to be copied from the existing data list and click 
[Copy.] 
The selection or entry screen for the copy destination additional function data number will appear.  
Select or enter the copy destination data number. 
 
 
■ Delete 
Select the desired additional function data number to be deleted from the existing data list and click 
[Delete.] 
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TEACHING DATA CHANGE 

– SEQUENCER PROGRAM 

                       

 

Sequencer program data is a part of the C&T data.  Before creating and editing sequencer program 
data, you need to open the C&T data. 
 
Click [Sequencer] on the [Data] pull-down menu.  The list of sequencer program data will appear. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

■ New (Add) 
Click [Add] in the lower left corner of the box and select a sequencer program data number.  The edit 
dialog box for the selected sequencer program data will appear. 

 
 

■ Edit 
To edit existing sequencer program data, select the desired data number to be edited from the list and 
click [Edit.]  The edit dialog box for the selected sequencer program data will appear. 

 
 

You can enter or change sequencer program data in the same way as you would for point job data.  
You can enter a name for sequencer program data.  Up to 10 one-byte characters can be used. 
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■ Copy 
Select the desired sequencer program data number to be copied from the list and click [Copy.] 
The selection or entry screen for the copy destination sequencer program data number will appear.  
Select or enter the copy destination data number. 
 
 
■ Delete 
Select the desired sequencer program data number to be deleted from the list and click [Delete.] 
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TEACHING DATA CHANGE 

– RUN MODE PARAMETER 

                       

 

Run mode parameter is a part of the C&T data.  Before setting the run mode parameter, you need to 
open C&T data. 
Run mode parameter consists of the following items.  Select the desired item to be changed. 
 
 
■ IO Settings 
Program Number Changing Way 
Program Number Reading Code 
IO-SYS Function Assignment 
IO-S Function Setting 
 
 
■ Job and Sequencer on Run Mode 
Job on Power ON  
Job on Emergency Stop 
Job on Playback Error 
Job on System Error 
Job on Start of Run Mode 
Job on Start of Cycle 
Job on End of Cycle 
Job on Stopping 
Job on Starting 
Job while Stopping (Cycle Top) 
Job while Stopping (In Cycle) 
Sequencer Program on Run Mode 

 
 

■ Point Reset Settings 
Reset at Power ON  
Reset at Emergency 
Reset at Going Home 
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ROBOT OPERATION VIA PC 

                       

 

To establish communication between the PC and the robot or to operate the robot via the PC, click 
[Robot] on the menu bar.  The following pull-down menu will appear. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 To operate the robot via the PC in the JS 
series, you need to connect the grip switch to 
the teaching pendant connector on the 
control box. 
In the JR2000N series, if a teaching pendant 
with an emergency stop switch and an enable switch is used, you need to also connect the grip 
switch to the teaching pendant connector. (See Page 4) 
 

Be sure to turn off the 
power to the PC and the 
robot before inserting or 
removing the cable. 

 The robot can execute [JOG (JOG Teaching)], [GO Move], and [GO plus Move] operations only 
in the teaching mode.  Enter the teaching mode using the select key switch on the control box. 

PC Operation                                                JS/JSR4400N SCARA Robot 
JSG GANTRY Robot 

JR2000N Desktop Robot  

36



 If a teaching pendant without an enable switch is used with the JR2000N series, it is not 
necessary to press the enable switch on the grip switch when instructed to do so in the manual. 

 

 

 

■ Mechanical Initialization (for the JR2000N series only) 
Execute mechanical initialization of the robot. 
Select “Meca Initialize” from “Robot” pull-down menu in the menu bar (while pressing the enable 
switch.)  The robot executes mechanical initialization.  The robot will not move unless mechanical 
initialization is executed after the robot power is turned ON. 
 

 

■ Motor Power ON (for the JS series only) 
Use this function to turn the motor power to the robot ON. 
Click [Motor Power ON] on the [Robot] pull-down menu.  The motor power to the robot will be turned 
ON. The robot cannot start unless the motor power is ON. 
 

 

■ GO Move 
Click [GO Move] on the [Robot] pull-down menu while pressing the enable switch. 
Each robot Axis will shift to the point coordinates where the cursor blinks. 
 
 
■ GO plus Move 
Click [GO Plus Move] on the [Robot] pull-down menu while pressing the enable switch. 
Each robot Axis will shift to the point coordinates where the cursor blinks, and then the cursor will shift 
to the next point. 
 
 
■ Point Playback/Test Running 
Click [Point Playback] or [Test Running] on the [Robot] pull-down menu while pressing the enable 
switch. 
These two operations will be executed according to the C&T data stored in the robot RAM.  For 
teaching data created using the JR C-Points and stored in the PC, first execute [Send C&T Data] in 
order to execute [Point Playback] or [Test Running.] 
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■ JOG (JOG Teaching) 
Use this function to register point coordinates in JOG mode. 
Place the cursor on the point to be registered and then click [JOG] on the [Robot] pull-down menu. 
The JOG dialog box will appear. (See next page) 
If you select a point other than normal job points (e.g. work home), click the JOG icon (    ) in the 
point setting dialog box. 

 
 

• Mode, Servo State (for the JS series only) 
You can select the position entry mode for the robot.  If you select [Direct], set [Servo State] to [Free] 
(Servo OFF.)  Any Axis set to [Hold] cannot shift in the Direct mode. 
You can enter the coordinate values in the “Coordinates” (X, Y, Z, R) sections using the numeric keys. 

 
 If you start the robot in the “Servo Free” (Servo OFF) state, any Axis set to [Free] will not shift.   

Before starting the robot, set [Servo State] to [Hold] (Servo ON) or change [Mode] to [JOG.]  
When turning to the JOG mode, each Axis automatically will be Servo ON state. 

  
 

• Coordinate System (for the JS series only) 
You can select the coordinate system for the robot.  If [J1-J2] is selected, the JOG key function will 
change from [X, Y, Z, R] to [J1, J2, J3, J4.] 

 
 

• Point Number (to be registered) 
The number of the point where the cursor blinks when opening the dialog box will be displayed here.  
You can change the number.  This item will not appear if you do not select a normal job point. 

 
 

• Point Job 
Click the “▼” on the right side of [Point Job] to display the list of the point job data registered in the 
C&T data.  The selected point job data will be executed if you click [Execute] while pressing the 
enable switch. 
Note that the robot executes the point job data stored in the robot.  If the point job data to be 
executed differs from that stored in the robot, you need to send the data to the robot (execute [Send 
C&T Data]) first. 
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• JOG Key 
Click these buttons while pressing 
the enable switch on the grip 
switch.  The corresponding robot 
Axis will shift.  Release the 
button to stop. 
The Axis display varies according 
to the selected coordinate 
system. 
 

 

• Speed (for the JS series only) 
You can select the JOG shifting 
speed between [Low], [Middle], 
and [High.] 
 

• Coordinates 
The point coordinates where the 
cursor blinks when opening the 
dialog box are displayed here.   
Click [Robot Pos’n] to display the 
current robot position coordinates 
and [Point Pos’n] to display the 
designated point coordinates.   
Click [GO] while pressing the 
enable switch to shift each robot 
Axis to the currently displayed 
position coordinates. 
 

 

• Arm Shape 
Select [Righty] or [Lefty] and then click [GO] while pressing the enable switch.  The robot will shift to 
the position coordinates that the selected Arm is pointing to. 
 

 

• Register 
Click this button to fix the coordinates and to close the dialog box. 
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• GO 
Click this button while pressing the enable switch.  Each robot Axis will shift to the currently displayed 
position coordinates. 

 

 

• Mechanical Initialization (for the JR2000N series only) 
Execute mechanical initialization of the robot.  The robot will not move unless mechanical initialization 
is executed after the robot power is turned ON. 
 

• Motor Power ON (for the JS series only) 
Click this button to turn the motor power to   the robot ON.  The robot cannot start unless the motor 
power is ON. 
 

• Close 
Click this button to abandon the coordinates and to close the JOG dialog box. 
 

 

If the JOG dialog box is open, you can shift the robot Axes using the PC keyboard. 
 

Axis Key Axis Key 
-X D -J1 D 
+X F +J1 F 
-Y E -J2 E 
+Y R +J2 R 
-Z C -J3 C 
+Z V +J3 V 
-R T -J4 T 

X-Y 

+R Y 

 

J1-J2 

+J4 Y 
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 If you cannot operate the robot via PC, open “System Information” to confirm the connection 
between the PC and the robot.  If the System Information dialog box opens normally, confirm 
the following.  If you still cannot execute the JOG operation even after having checked all items, 
try [Diagnosis Mode] (teaching pendant required) or contact your dealer. 

 

 

 

 If a teaching pendant without an enable switch and 
an emergency stop switch is used with the 
JR2000N series, a grip switch is not necessary. 

 
 If a teaching pendant without an enable switch is 

used with the JR2000N series, it is not necessary 
to press the enable switch. 

 

 

 For the JR2000N series only 
 

 

 

 

 For the JS series only 
 

 

 

 

 

 

 

 
 For the JS series only 

Set [Mode] to [JOG] in the JOG dialog box.  All Axes 
will automatically be in the Servo ON state. 
 

 

The grip switch 
is connected. 

The enable switch 
is pressed. 

<Unable to operate from PC> 

The motor power to 
the robot is ON. 

The robot is in the 
teaching mode. 

Each robot Axis is in 
the Servo ON state. 

Mechanical initialization 
is executed after the 
robot power is turned 

ON. 
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■ External I/O 
Click [External I/O] on the [Robot] pull-down menu.  The current external I/O status of the robot will 
be displayed. 
 

 

 

Red lamps indicate the signals currently ON. 
Click the buttons on the dialog box to toggle the external signals ON or OFF. 
 

 

 When Using I/O-U (Optional for the JS series only) 
I/O-U (optional) is an extension of I/O-H.  However, the above I/O-H ON/OFF display is not the I/O-U 
status because it only displays information on the internal board in the control box. 

 

With I/O-U
I/O-H 

I/O-U 
 Robot 
 

 
 
Tool Controller 

Control 
Box 

 

Tool  

 

 

 

Without I/O-U

Control Box 

I/O-H 
Robot 

Tool 

 

 

 

 

  

Internal Board  
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EXTERNAL START CHANNEL 
                       

 

■ External Start 
You can select one of the following two channels for the robot to receive the external start signal 
through.  You cannot select both at one time. 

• COM1 
• I/O-1 

 

 

Click [External Start] on the [Robot] pull-down menu. 
The External Start dialog box will appear. 
Select the desired start channel and click [OK.] 
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SYSTEM ERROR INFORMATION 
RUN ERROR INFORMATION 

                       

 

Click [System Error Information] or [Run Error Information] on the [Robot] pull-down menu.  Any error 
information regarding the connected robot will be read out and displayed. 
If an error occurred while the robot was not connected to the PC, turn off the power to the robot and 
the PC briefly before connecting the two.  Then start up them to read out the error information. 
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PRINT 
                       

 

You can print out the C&T data. 
 

 

Click [Print] on the [File] pull-down menu. 
The Print setting dialog box will appear. 
Select the desired item to be printed and click [OK.] 
Set the print range to [All] to select all the C&T data 
(the unit described on Page 12.) 
 

The Print confirmation dialog box will appear. 
Click [OK] to start printing. 
 

 

 

 

 

 

 

 

 

 

Click [Print Preview] to see the print image.  If you want to print out a particular program or point job, 
locate the page numbers using the Print Preview and then set the page count in the Print dialog box. 
 
Click [Print Setup] to change the print setting. 
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CUSTOMIZING DATA – TMC SETTING 

                       

 

TMC setting (Teaching Mode Customizing Data) is customizing data which is not restricted by account.  
Settings can be changed without logging in. 
 
Select the item you want to set from the “Set T.M.C” pull-down menu in the menu bar.  The setting 
dialog for the selected item will be displayed. 
Select the item you want to set from the dialog box and click [OK.] 
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CUSTOMIZING DATA - ACCOUNT 
                       

 

To define or create customizing data (except for TMC setting), it is necessary to login by setting an 
account.  Up to 50 accounts can be set.  Once you login, you remain logged-in under the same 
account until you logout or terminate JR C-Points. 
It is not possible to log in simultaneously using multiple accounts. 
 
Customizing data (except for TMC setting) is protected by account (account restriction.)  Access 
restriction varies depending on the type of “Protect Mode” (See the table below.)  Protect Mode can 
be set for each set of data. 
 
<Access Restriction to Other Accounts> 

Protect Mode 
 

No 
Restriction Public Protected Private  

Use data ○ ○ ○ ×  

View contents ○ ○ × ×  

Change 
contents ○ × × ×  

 

 

 

 

■  Login 
 

To login using the existing account, select “Login” 
from the pull-down menu under “Account” in the 
menu bar.  The dialog box shown to the right will 
be displayed. 
Enter your login name and security code and click 
[OK.] 
To login using a new account, see “Make 
Account.” 
 

 This robot has a special account which does not require entry of a login name (user) and 
security code.  This account is useful for creation or setting customizing data which does not 
require protection by an account. 
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■  Logout 
To logout, select “Logout” of the pull-down menu from “Account” in the menu bar. 
 

 

 

 

 

 

 

 

 

 

 

 

 

■  Make Account 
To make a new account, select “Make Account” 
from the pull-down menu under “Customize” in 
the menu bar.  The dialog box shown to the 
right will be displayed. 
Enter a Login Name and Security Code twice 
and click [OK.] 
You can now login using the new account. 
 

 

 

■  Delete Account 
To delete an account, select “Delete Account” from the pull-down menu under “Account” in the menu 
bar.  If an account is deleted, all customizing data included in the account will be deleted too. 

 

 

 

■  Change Security Code 
Change the security code used to login. 
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■  Inhibit Copying 
You can choose Valid or Invalid.  If “Valid” is set under “inhibit Copying”, when C&T data is sent from 
PC to the robot it will not be sent unless the robot is using the same account. 
 

 

 

■  Inhibit Copying to the Other Robot 
You can choose Valid or Invalid.  If “Inhibit Copying to the Other Robot” is set to “Valid” when C&T 
data is sent it will not send if the unit identification number is different. 
 

 

 

■  Transfer 
Transfer all account data being logged in to another account. 
Select “Transfer” from the pull-down menu under “Account” in the menu bar and enter an account to 
transfer to.  If data is transferred, all the account data in the original location will disappear. 
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CUSTOMIZING DATA 

                       

 

 Customizing data is protected by account.  It is not possible to edit customizing data through 
another account.  To create or set customizing data, select an account to login under. 

 
Select the customizing data you want to create or set from the pull-down menu under “Customize” in 
the menu bar.  A list of customizing data will be displayed.  Click [Add] to create new customizing 
data.  Click [Edit] to modify the existing data.  The setting dialog box for the selected item will be 
displayed. 
To copy or delete data, specify the data and select [Copy] or [Delete.] 
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ROBOT SYSTEM VERSION UPGRADE 
                       

 

Robot system software is built-in system software that controls the robot.  Follow the steps below to 
upgrade the robot system software. 
“Robot System Software” is the file with the extension “.jsy”, included in Operation Manual CD-ROM. 

■ JS Series: JsSyp+++_***.jsy 
■ JR2000N Series: JRN_+AC_***.jsy 
(“+” or “+++” indicates the application and “***” indicates the version number.) 

 
1. Turn the power to the robot OFF.  Remove the switch cover from the front of the control box (for 

the JS series) or the left side of the robot body (for the JR2000N series) to toggle the special 
mode switch to ON. 

 

 

       <JS Series> 
     Control Box (Front) 

Inside the Cover
Special Mode Switch

 

 

 

 

 

 

 

 

 

    <JR2000N Series> 
     Left Side of the Body 

 

Special Mode Switch
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2. Turn the power to the robot ON and insert the Operation Manual CD-ROM into the PC CD drive. 
 
3. Start up “JR C-Points” and click [Send Robot System Software] on the [Robot] pull-down menu. 

The following dialog box will appear. 
 

 

 

 

 

 

 

 

 

 

 

 
 
4. Click [Open] and specify the CD drive into which the Operation Manual CD-ROM has been 

inserted. 
 
5. Select the “Robot System Software” file and click [Open.] 

The file name will be displayed in the dialog box title bar. 
 
6. Click [Send] to start sending the robot system software. 
 

<Robot System Software Files> 
■ JS Series: JsSyp+++_***.jsy 
■ JR2000N Series: JRN_+AC_***.jsy 
(“+” or “+++” indicates the application and “***” indicates the version number.) 

 
 
7. After the transmission, turn the power to the robot OFF.  Toggle the special mode switch to OFF 

and reattach the switch cover. 
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CAD DRAWING FILE CONVERSION (Dxf2Robot) 
                       

 

The “Dxf2Robot” software is designed to convert a CAD drawing file (with the extension “.DXF”) to a 
file that can be read using JR C-Points. 
The converted file (with the extension “JCS”) can be read using the [Import] function (in the [File] 
menu) of JR C-Points. 
 
 
Preparation 
The “Dxf2Robot” software cannot be installed using the same installation process as for JR C-Points.  
Copy the “D2RJ.EXE file from the ”JR C-Points” CD-ROM to a local disk. 

(Copy Destination Example) C:¥Program Files¥JANOME¥JRPSJ 
 
 
Operation
1. Double-click the D2RJ.EXE icon.  The following dialog box will appear. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Click [Select (Add)] to select a DXF file to be converted and then click [Open.]  The selected file 
name will be displayed in the “List of source files (DXF Files)” section. 
If you want to convert multiple DXF files, repeat this procedure to display the file names in the 
“List of source files (DXF Files)” section. 
To abandon the conversion of a file, select (highlight) the file name to be canceled and click 
[Cancel.] 
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3. Click [Browse] to designate a folder to save the converted file(s) into. 
 
4. Click [Convert All.]  All the files displayed in the “List of source files (DXF Files)” section will be 

converted to JCS files and saved in the location selected under “Saving Folder” section. 
Click [Convert] to convert only the selected (highlighted) file in the “List of source files (DXF Files)” 
section and save it in the location selected under “Saving Folder” section. 
 

5. After the transmission is complete, click [Exit] to exit “Dxf2Robot.” 
 

 

 

Notice 
• Up to 500 DXF files can be converted at one time. 
• The DXF file to be converted should contain only one layer. 
• The DXF file to be converted should not contain either the dimension line, frame, proxy object 

(zombie), or 3D solid. 
• The DXF file to be converted should contain less than 10,000 functions. 

Functions to be converted are as follows: 
ARC (arc), CIRCLE (circle), LINE (line), POINT (point), POLYLINE (continuous line), 
VERTEX (vertex), LWPOLYLINE (continuous line), SEQEND (end of continuous line), 
ENDSEC (end of section) 
 

• An arc will be converted counterclockwise except when an arc and a line are combined. 
• A circle will be converted as two arcs.  In this case, the start point of the arc is always right side 

(three o’clock position) of circle. 
• The unit of length cannot be converted.  Values in the DXF file will be converted directly.  You 

can select either “mm” or “inch” when reading the file with the “JR C-Points.” 

Start Point 

Counter- 
clockwise 

e.g. Combination of  
Arc and Line
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CONVERTING DATA 

FROM JR2000 INTO JR2000N 

                       

 

If you are using JR2000 teaching data as JR2000N C&T data, it is necessary to convert the data.  To 
convert data, follow these 3 steps. 
 

1) Using “JR-Points”, load data onto the PC from the JR2000. 
2) Using “JR C-Points”*, open the data sent in 1). 
3) Using “JR C-Points”*, send the data from your PC to the JR2000N. 

 
 

JR2000 

Connect 

PC (JR-Points) JR2000N

Connect 

PC (JR C-Points) 

 
Teaching Data 

 

 

 

 

 

 

 

 
 
 
* As well as “JR C-Points”, “JR C-Points Limited Edition” (included in Operation Manual CD-ROM) can 

also be used to convert data. 
 

 You can connect one PC to both the JR2000 series and the JR2000N series robots together.  It 
is also possible to connect the PC only to the JR2000 series robot to receive teaching data, 
disconnect the JR2000 robot and then connect the JR2000N series robot to send the teaching 
data. 
(To convert data using one PC, both “JR-Points” and “JR C-Points” have to be installed on the 
PC.) 

 
 

Be sure to turn the power to the 
robot and PC OFF before 
connecting or disconnecting cables. 
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Follow the steps below to convert teaching data. 
(For a PC with “JR-Points” and “JR C-Points” installed, connected to the JR2000 series and JR2000N 
series robots.) 
 
1. Turn the power to the robot and PC ON.  In Run mode, the robot has to be in stand-by to run.  

In other modes, it has to be in a base state. 
 
2. Start up “JR-Points” on the PC and set the port status to a COM port connected to the JR2000 

series robot. 
     [Robot]  [COM Status] PC 

 
3. Transfer teaching data from the JR2000 series robot. 

     [Robot]  [Receive Data] PC 

 
4. When data transfer is completed, the data is opened in “JR-Points.”  Name the received data 

and save it. 
     [File]  [Save As] PC 

 
5. Exit “JR-Points” and start up “JR C-Points.” 
 
6. Set the port status to a COM port connected to the JR2000N series robot. 

     [Robot]  [COM Status] PC 

 
7. Open the data file from the JR2000 series robot. 

     [File]  [Open] PC 

 
8. Send the data to the JR2000N series robot.  Note that when data is sent from the PC to the 

robot, any data stored in the robot is deleted. 
     [Robot]  [Send Data] PC 

 
 
 

 For operation environment of “JR-Points”, refer to the operation manual for JR-Points. 
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COMMUNICATION CABLE (RS-232C) WIRING 

                       

 

Use a 9-pin D-SUB connector for the robot. 
The robot is cross-cabled as follows.  Use a straight cable when connecting the host (e.g. PC) and 
the robot. 
 

 

■ Host Side: 9-Pin D-SUB 

 

COM1 (RS-232C Port) 
 
Robot       Host (PC) 

PIN No. Terminal Function  PIN No. Terminal Function 
3 RXD Receive Data  3 TXD Transmit Data 
2 TXD Transmit Data  2 RXD Receive Data 
8 RTS Request to Send  8 CTS Clear to Send 
7 CTS Clear to Send  7 RTS Request to Send 
5 GND Ground  5 GND Ground 

Connector: 9-Pin D-SUB    Connector: 9-Pin D-SUB 
 

 

 

■ Host Side: 25-Pin D-SUB 
 

COM1 (RS-232C Port) 
 
Robot       Host (PC) 

PIN No. Terminal Function  PIN No. Terminal Function 
3 RXD Receive Data  2 TXD Transmit Data 
2 TXD Transmit Data  3 RXD Receive Data 
8 RTS Request to Send  5 CTS Clear to Send 
7 CTS Clear to Send  4 RTS Request to Send 
5 GND Ground  7 GND Ground 

Connector: 9-Pin D-SUB     Connector: 25-Pin D-SUB 
 
 
For the host (PC) side, use a cable compatible with your PC. 
The 9-pin D-SUB is normally connected to the serial port marked with [I O I O] on the rear side of the 
PC. 
 

PC Operation                                                JS/JSR4400N SCARA Robot 
JSG GANTRY Robot 

JR2000N Desktop Robot  

57



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  JANOME  Sewing Machine Co., Ltd. 

Industrial Automation Systems Division 

Zip Code: 193-0941 
1463 Hazama-machi, Hachioji-shi, Tokyo, Japan 

Tel: +81-426-61-6301 
Fax: +81-426-61-6302 

 
The specifications of the robot or the contents of this manual may be modified without 
prior notice to improve its quality. 
No part of this manual may be reproduced in any form, including photocopying, 
reprinting, or translation to another language, without the prior written consent of 
JANOME. 

 
©2006, JANOME Sewing Machine Co., Ltd., All rights reserved. 

 

 

    27 January 2006 

970809104 as of 12/2005 

 


	JS/JSR/JSG/JR_PC Operation
	FOR YOUR SAFETY 
	PREFACE 
	CONTENTS 
	HARDWARE REQUIREMENTS 
	CONNECTION 
	INSTALLATION AND UNINSTALLATION 
	START AND EXIT 
	SCREEN 
	OPERATION PROCESS 
	C&T DATA 
	NEW 
	OPEN/SAVE 
	COMMUNICATION 
	COMMUNICATION SETTING 
	CONNECTION CONFIRMATION/SYSTEM INFORMATION
	SCREEN DISPLAY 
	TEACHING DATA – PROGRAM 
	TEACHING DATA CHANGE – POINT JOB DATA 
	TEACHING DATA CHANGE – ADDITIONAL FUNCTION DATA 
	TEACHING DATA CHANGE – SEQUENCER PROGRAM
	TEACHING DATA CHANGE – RUN MODE PARAMETER
	ROBOT OPERATION VIA PC 
	EXTERNAL START CHANNEL 
	SYSTEM ERROR INFORMATION 
	RUN ERROR INFORMATION 
	PRINT 
	CUSTOMIZING DATA – TMC SETTING 
	CUSTOMIZING DATA - ACCOUNT 
	CUSTOMIZING DATA 
	ROBOT SYSTEM VERSION UPGRADE 
	CAD DRAWING FILE CONVERSION (Dxf2Robot) 
	CONVERTING DATA FROM JR2000 INTO JR2000N
	COMMUNICATION CABLE (RS-232C) WIRING 


